
Voyager® 8
Call Slip Dæmon User’s Guide

June 2011
 



CONFIDENTIAL INFORMATION
The information herein is the property of Ex Libris Ltd. or its affiliates and any misuse or abuse will result in 
economic loss. DO NOT COPY UNLESS YOU HAVE BEEN GIVEN SPECIFIC WRITTEN AUTHORIZATION 
FROM EX LIBRIS LTD.

This document is provided for limited and restricted purposes in accordance with a binding contract with Ex 
Libris Ltd. or an affiliate. The information herein includes trade secrets and is confidential.

DISCLAIMER
The information in this document will be subject to periodic change and updating. Please confirm that you 
have the most current documentation. There are no warranties of any kind, express or implied, provided in 
this documentation, other than those expressly agreed upon in the applicable Ex Libris contract. This 
information is provided AS IS. Unless otherwise agreed, Ex Libris shall not be liable for any damages for use 
of this document, including, without limitation, consequential, punitive, indirect or direct damages.

Any references in this document to third-party material (including third-party Web sites) are provided for 
convenience only and do not in any manner serve as an endorsement of that third-party material or those 
Web sites. The third-party materials are not part of the materials for this Ex Libris product and Ex Libris has no 
liability for such materials.

TRADEMARKS
"Ex Libris," the Ex Libris bridge , Primo, Aleph, Alephino, Voyager, SFX, MetaLib, Verde, DigiTool, 
Preservation, URM, ENCompass, Endeavor eZConnect, WebVoyáge, Citation Server, LinkFinder and 
LinkFinder Plus, and other marks are  trademarks or registered trademarks of Ex Libris Ltd. or its affiliates.

The absence of a name or logo in this list does not constitute a waiver of any and all intellectual property 
rights that Ex Libris Ltd. or its affiliates have established in any of its products, features, or service names or 
logos.

Trademarks of various third-party products, which may include the following, are referenced in this 
documentation. Ex Libris does not claim any rights in these trademarks. Use of these marks does not imply 
endorsement by Ex Libris of these third-party products, or endorsement by these third parties of Ex Libris 
products.

Oracle is a registered trademark of Oracle Corporation.

UNIX is a registered trademark in the United States and other countries, licensed exclusively through X/Open 
Company Ltd.

Microsoft, the Microsoft logo, MS, MS-DOS, Microsoft PowerPoint, Visual Basic, Visual C++, Win32, 
Microsoft Windows, the Windows logo, Microsoft Notepad, Microsoft Windows Explorer, Microsoft Internet 
Explorer, and Windows NT are registered trademarks and ActiveX is a trademark of the Microsoft Corporation 
in the United States and/or other countries.

Unicode and the Unicode logo are registered trademarks of Unicode, Inc.

Google is a registered trademark of Google, Inc.

Copyright Ex Libris Limited, 2011. All rights reserved.

Document released: June 2011

Web address: http://www.exlibrisgroup.com



Contents

 iii

Table of Contents

About This Document 
• Purpose vii
• Intended Audience vii
• Reason for Reissue vii
• How to Use This Document vii
• Conventions Used in This Document viii
• Document Reproduction/Photocopying ix
• Comment on This Document ix

1 Getting Started
• Introduction 1-1
• Purpose of this Chapter 1-1
• Prerequisite Skills and Knowledge 1-1
• Before You Begin 1-2

Checklist 1-2
Help 1-2
Log In 1-3
Login Information 1-4

2 Overview of Call Slip Dæmon
• What Is Voyager Call Slip Dæmon? 2-1
• Functional Overview 2-2

Menu Items 2-2
File Menu 2-2
Edit Menu 2-3
Help Menu 2-4

Tabbed Functions 2-5



iv  

Call Slip Dæmon User’s Guide

Contents

3 Processing Call Slip Requests
• Call Slip Requests 3-1
• Pending Tab 3-1

Retrieving Current Requests 3-2
Total Requests & Printed Requests 3-3

• Printing Pending Requests 3-4
• Filling a Call Slip Request 3-8
• Link Item to Request 3-10
• Select Another Item 3-16
• Reassign Request 3-18
• Call Slip Reassignment History 3-20
• Displaying Processed Requests 

(History Tab)3-21
View the List of Processed Call Slip Requests 3-21

4 Customizing Your System
• Overview 4-1
• Preferences 4-1

New Request Options 4-2
Update and Email Send Interval 4-3
Use Alert Sound 4-3
Automatically Print New Requests 4-3

Sort Pending Requests by 4-3
Default Find Method 4-4
Process Options 4-4

Force Item Search on Process 4-4
Verify Create New Item or Add Barcode 4-5

Printer Options 4-5
Tab Width 4-5
Standard Font 4-5
Alternate Font 4-5

Email Options 4-6
Regular Requests 4-6
Universal Borrowing Requests 4-6

Save Preferences 4-7
• Defining the Callslip.ini File 4-7



 v

Table of Contents

Contents
Callslip.ini File Example 4-8
General Stanza 4-15

LocationCode= Variable  4-15
NewItem= Variable  4-17
AddBarcode= Variable  4-18

Preferences Stanza 4-19
Print Options Stanza 4-19
Email Options Stanza 4-19
Template Stanzas 4-20

Action Codes 4-20
Field Codes 4-21
MARC Variable Data 4-23

Formatting the Data 4-25
Error Handling 4-25

Call Slip Reassignment History 4-26
Call Slip Promote History 4-26
Initiating and Ending Action Codes 4-27
Printing Field Information 4-27
Printing in the Alternate Font 4-28
Changing Font Size 4-28
Inserting a Blank Line 4-29
Inserting a Tab 4-29
Example 4-29

IN Index IN-1



vi  

Call Slip Dæmon User’s Guide

Contents



 vii

About This Document 

Purpose

This document provides instructions for customizing Voyager Call Slip Dæmon, 
and steps for processing call slip requests.

Intended Audience

This document is intended for Voyager customers who process call slip requests 
and/or need to tailor the call slip function for the institution’s use.

Reason for Reissue

This user’s guide is being reissued for the following reason:

• Addition of change password information to Table 2-1 on page 2-2.

How to Use This Document

This document consists of the following:

Chapter 1 “Getting Started
Chapter 1 provides the prerequisites for using Voyager Call Slip 
Dæmon and other considerations for getting started.
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Chapter 2 Overview of Call Slip Dæmon
Chapter 2 provides a brief functional overview of Voyager Call 
Slip Dæmon.

Chapter 3 Processing Call Slip Requests
Chapter 3 provides the steps for processing call slip requests.

Chapter 4 Customizing Your System
Chapter 4 provides an explanation of the options for customizing 
Voyager Call Slip Dæmon.

Index The Index is an alphabetical, detailed cross-reference of topics.

Conventions Used in This Document

The following conventions are used throughout this document:

• Names of commands, variables, stanzas, files, and paths (such as 
/dev/tmp), as well as selectors and typed user input, are displayed in 
constant width type. 

• Commands or other keyboard input that must be typed exactly as 
presented are displayed in constant width bold type.

• Commands or other keyboard input that must be supplied by the user are 
displayed in constant width bold italic type.

• System-generated responses such as error messages are displayed in 
constant width type.

• Variable portions of system-generated responses are displayed in 
constant width italic type.

• Keyboard commands (such as Ctrl and Enter) are displayed in bold.

• Required keyboard input such as “Enter vi” is displayed in constant 
width bold type.

• Place holders for variable portions of user-defined input such as ls -l 
filename are displayed in italicized constant width bold type.

• The names of menus or status display pages and required selections from 
menus or status display pages such as “From the Applications drop-down 
menu, select System-wide,” are displayed in bold type.

• Object names on a window’s interface, such as the Description field, the 
OK button, and the Metadata tab, are displayed in bold type.

• The titles of documents such as Curator Web Client User’s Guide are 
displayed in italic type.

• Caution, and important notices are displayed with a distinctive label such 
as the following:
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About This Document

NOTE:
Extra information pertinent to the topic.

! IMPORTANT:
Information you should consider before making a decision or configuration.

! CAUTION:
Information you must consider before making a decision, due to potential 
loss of data or system malfunction involved.

TIP:
Helpful hints you might want to consider before making a decision.

RECOMMENDED:
Preferred course of action.

OPTIONAL:
Indicates course of action which is not required, but may be taken to suit your 
library’s preferences or requirements.

Document Reproduction/Photocopying

Photocopying the documentation is allowed under your contract with Ex Libris 
(USA) Inc. It is stated below:

All documentation is subject to U.S. copyright protection.  CUSTOMER 
may copy the printed documentation only in reasonable quantities to aid 
the employees in their use of the SOFTWARE.  Limited portions of 
documentation, relating only to the public access catalog, may be copied 
for use in patron instruction.

Comment on This Document

To provide feedback regarding this document, use the Ex Libris eService or send 
your comments in an e-mail message to docmanager@exlibrisgroup.com.
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Getting Started

Introduction

This chapter describes the prerequisites for beginning work in Voyager Call Slip 
Dæmon.

Purpose of this Chapter

This chapter’s purpose is to provide:

• Prerequisites for using and tailoring Voyager Call Slip Dæmon.

• Instruction for logging in to Voyager Call Slip Dæmon.

Prerequisite Skills and Knowledge

To use this document effectively, you need knowledge of the following:

• Basic Microsoft Interface navigation

• Basic UNIX commands and navigation

• Basic Voyager System Administration Module
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Before You Begin

Before you can customize Voyager Call Slip Dæmon, the client and server 
components must be installed and running. Review the following information to 
prepare for using Voyager Call Slip Dæmon.

Checklist

You must complete the following tasks to process call slip requests in Voyager 
Call Slip Dæmon.

• Enter Call Slip Definitions in the Voyager System Administration module

• Enter Call Slip Rules in the Voyager System Administration module

• Enter No-Fill Reasons in the Voyager System Administration module

Optionally, you may also want to complete the following tasks.

• Customize print options in the callslip.ini file

• Customize email options in the callslip.ini file

• Enter call slip status codes in the opac.ini file

• Customize Messages in Voyager System Administration OPAC 
Configuration

• Customize printing options in the circ.ini file

Help

Use the online help function through the Help Menu to assist with your questions 
while using Call Slip Dæmon.

Figure 1-1. Help menu

You can also access context-sensitive help by pressing F1.



 1-3

Chapter 1: Getting Started

Log In

When you launch Voyager Call Slip Dæmon, a log-in window displays. Use the 
following to log into Voyager Call Slip Dæmon.

Procedure  1-1.  Logging In

1. Enter your Operator ID and Password.  See Figure 1-2.

NOTE:
The Operator ID and Password are set up by the Voyager System Administrator 
through the Security Configuration function within the Voyager System 
Administration module.

2. Click OK.

Figure 1-2. Call Slip Dæmon log-in window

3. (Optional) Select the Call Slip Group, and click OK. See Figure 1-3.
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Result: The first time staff log in to Voyager Call Slip Dæmon the Call Slip Group 
needs to be selected. This selection is then permanently stored in the 
callslip.ini file in the LocationCode field under the [General] stanza 
thus eliminating the need to repeat this step. See LocationCode= Variable on 
page 4-15 for more information.

Figure 1-3. Select Call Slip Group

Login Information

You can display your Operator Name, Operator ID, Location, and Process 
Method by selecting Login Information from the File menu. See Figure 1-4.  

Figure 1-4. Call Slip Dæmon Login Information dialog box

Your Process Method determines what happens to an item once you process 
and fill a call slip request. Your Process Method may be one of three following 
possibilities:

• Place on Hold

• In Transit for Hold

• Charge to Patron
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See Call Slip Definitions in the Call Slip (Closed Stacks) section of the Voyager 
System Administration User’s Guide for more detailed information about Call Slip 
Process Methods.
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Overview of Call Slip Dæmon

What Is Voyager Call Slip Dæmon?

Voyager Call Slip Dæmon is a tool designed to enhance the productivity of library 
staff when processing call slip requests from patrons. Requests can be handled 
immediately when submitted by a patron or queued up and handled as a group of 
requests. Call Slip Dæmon is designed to be flexible to meet the scheduling 
requirements of library staff everywhere.

Call Slip Dæmon incorporates many features to enhance the processing of call 
slip requests such as:

• Virtually unlimited pre-set formatting options for printing call slip requests

• Optional Automatic Print New Request feature

• Email facility to communicate the status of processed requests to the 
requestor

• Time-saving stored responses from which to select

• Free-key area to include non-standard responses to requests

• Update Interval option to specify how often to update the Call Slip Dæmon 
request queue

• Optional Alert Sound feature providing an audio signal to notify staff of a 
new incoming request
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Functional Overview

Voyager Call Slip Dæmon combines menu options and a tabbed screen interface 
to aid library staff in navigating and processing call slip requests.

Menu Items

Call Slip Dæmon provides the following three menus for easy access to functions:

• File Menu

• Edit Menu

• Help Menu

File Menu

The File menu provides the main functions for Call Slip Dæmon such as get 
requests, print requests, and set preferences. A description of each File menu 
function is defined in Table 2-1 on page 2-2.  

Table 2-1. File Menu

Menu Item Description

Get Requests Retrieves new call slip requests from the server.

Login Information Displays your operator name, operator ID, and 
location.

Change Password Displays the dialog box for changing your password.

Your must password must:
• Be a minimum of 8 characters and no longer 

than 25 characters
• Contain, at least, two alphabetic characters
• Contain, at least, one numeric character from 0-

9
• Contain, at least, one of the following special 

characters:  !@#$%^&*?~":;'=-.,
• Be different from your previous password
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Edit Menu

The Edit menu provides the functions for processing call slip requests. See 
Figure 2-1.

Figure 2-1. Edit Menu

A description of each Edit menu function is defined in Table 2-2 on page 2-3.   

Print Displays a cascading menu. 

Selected prints the particular call slip request(s) that is 
highlighted on the Pending tab.  

New prints all of the new call slip requests that have 
not yet been printed. 

All prints all of the call slip requests on the Pending 
tab.

Print Setup Allows you to choose and set up a printer.

Preferences Displays the Preferences dialog box.

Exit Exits the Call Slip module.

Table 2-2. Edit Menu

Menu Item Description

Fill Request (Ctrl+F) Processes the request that is currently highlighted on 
the Pending tab as a Filled Request.  The processed 
request then displays on the History tab.

Table 2-1. File Menu

Menu Item Description
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Help Menu

The Help menu provides information about how to use Call Slip Dæmon and 
information about which version is installed. See Figure 2-2.

Figure 2-2. Help menu

A description of each Help menu function is defined in Table 2-3.   

No Fill Request Displays a menu of No Fill reasons (only the first 20 of 
the total list of No Fill reasons). Selecting a No Fill 
reason processes the request that is currently 
highlighted on the Pending tab as a No Fill Request.  
The processed request then displays on the History 
tab.

Link Item to Request 
(Ctrl + L)

Displays the Link Item dialog box.

Select another item 
from this Bib

Displays list of items for the active bibliographic record 
from which to select.

Reassign Request Displays list of call slip queues.

View Reassignment 
History

Displays reassignment history for the highlighted call 
slip request.

Table 2-3. Help Menu

Menu Item Description

Help Topics Displays the contents of Call Slip Help topics.

Ex Libris on the Web Provides links to Ex Libris Web content.

About Call Slip 
Dæmon

Displays the copyright notice and version number of 
your copy of Voyager Call Slip.

Table 2-2. Edit Menu

Menu Item Description
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Tabbed Functions

The Voyager Call Slip Dæmon contains two tabs Pending and History. See 
Figure 2-3.

Figure 2-3. Call Slip Dæmon tabs

The Pending tab displays a list of current call slip requests that have been placed.

The History tab displays a list of call slip requests that have been processed 
during the current Call Slip Dæmon session.

The following chapters describe in detail how to use and customize these 
functions for your environment.
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Processing Call Slip Requests

Call Slip Requests

Call slip requests in Voyager Call Slip Dæmon are displayed for library staff 
through the following two tabs.

• Pending

• History

The Pending tab displays new and pending call slip requests.

The History tab displays call slip requests that have been processed during the 
current login session.

This chapter describes in detail the information and functions provided on each of 
these tabs.

Pending Tab

A list of all new pending call slip requests is retrieved and placed on the Pending 
tab (see Figure 3-1) when you log in to the Call Slip Dæmon. (Dæmon is a Unix 
process. For this application, it runs and automatically checks and updates the 
queue for new incoming call slip requests.)
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The system automatically updates the Pending tab as specified by the setting 
entered for Update and Email Send Interval in Preferences.  The length of this 
interval determines the frequency with which new call slip requests automatically 
display on the Pending tab.  See Update and Email Send Interval on page 4-3 for 
more information.

The Find Request ID field and Find Item Barcode field (see Figure 3-1) can be 
used to search for a call slip request on the Pending tab.  Using these fields can 
expedite call slip processing by enabling the system to automatically locate a 
specific call slip request as compared to staff manually scrolling through a long list 
of requests.

Scanning technology can also be used to enter the required information into either 
of these fields.  To print the Request ID or Item Barcode as a barcode on the call 
slip printout, see Printing in the Alternate Font on page 4-28.

Figure 3-1. Call Slip Dæmon Pending tab

Retrieving Current Requests

To retrieve any new pending call slip requests after you have logged in, select Get 
Requests (see Figure 3-2) from the File menu. This queries the server and 
returns a list of all new pending call slip requests that have been submitted since 
the last time the queue was updated.
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Figure 3-2. Get Requests

Total Requests & Printed Requests

To determine the number of new call slip requests, look for the two numbers 
displayed in the top left corner of the Pending Item Information list box. See 
Figure 3-3.

The first number is the total number of call slip requests on the Pending tab. 

The second number is the total number of call slip requests that have not yet been 
printed. 

Figure 3-3. Number of call slips pending (total) and number of new call slips (not 
printed)

The procedure for searching for a pending call slip request is shown in 
Procedure 3-1, Searching for a Pending Request, on page 3-4.
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Procedure  3-1.  Searching for a Pending Request

Use the following to search for a pending request by Request ID or Item 
Barcode.

1. Enter the Request ID number associated with a call slip request in the Find 
Request ID field on the Pending tab, or type the Item Barcode associated with a 
call slip request in the Find Item Barcode field.

Optionally, place the cursor in the Find Request ID field or the Find Item 
Barcode field; and scan the Request ID or Item Barcode, respectively.

Result: This identifies the call slip to search for and activates the ellipsis button.  
This provides quick access to a specific call slip request when there is a long list 
of pending call slips.

2. Click the ellipsis button or press Enter. 

Result: The requested call slip displays highlighted on the Pending tab

Printing Pending Requests

Call slip requests can be printed from the Pending tab.  Voyager Call Slip Dæmon 
print options include the following.

• All highlighted call slip requests

• All new call slip requests that have not yet been printed

• All call slip requests on the Pending tab

The Voyager Call Slip Dæmon prints call slip requests according to the options set 
in the Print Setup dialog box, the Preferences dialog box (see Preferences on 
page 4-1), and the [Print Template] stanza in the callslip.ini file.  
See Defining the Callslip.ini File on page 4-7.

The procedure for using the Print Setup dialog box to set print options is shown in 
Procedure 3-2, Setting Up and Selecting Your Printer, on page 3-5.
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Procedure  3-2.  Setting Up and Selecting Your Printer

Printer setup and selection is handled through the File menu.  Use the following to 
select a printer and specify its setup.

1. Click the File menu.

Figure 3-4. Print Setup option

Result: The File options display.

2. Click Print Setup.

Result: The standard Print Setup Windows dialog box displays.  See Figure 3-5.
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Figure 3-5. Call Slip Dæmon/Windows Print dialog box

3. Follow normal steps to customize your printer setup in Windows using standard 
Windows Help (F1) functions to assist with this process.

Result: This identifies how and where the information is to print.

4. Click OK to store the printer selections for the current Call Slip Dæmon session.

The procedure for printing highlighted call slip requests is shown in Procedure 3-
3, Printing Highlighted Call Slip Request(s), on page 3-6.

Procedure  3-3.  Printing Highlighted Call Slip Request(s)

Use the following to print highlighted call slip requests.

1. Click the Pending tab.

Result: This displays the list of pending call slip requests.

2. Click to highlight one or more call slip requests.

Result: This identifies the call slips to be printed.

3. Select Print from the File menu.
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Result: The Print options display.

4. Select Selected from the cascading menu, or press Ctrl+S.

Result: The request(s) that is highlighted is sent to the printer.

The procedure for printing all new call slip requests is shown in Procedure 3-4, 
Printing All New Call Slip Requests, on page 3-7.

Procedure  3-4.  Printing All New Call Slip Requests

Use the following to print all the new call slip requests.

1. Click the Pending tab.

Result: This displays the list of pending call slip requests. See Total Requests & 
Printed Requests on page 3-3 for a description of how to determine the number of 
call slip requests that have not yet been printed.

2. Select Print from the File menu.

Result: The Print options display.

3. Select New from the cascading menu, or press Ctrl+N.

Result: All of the new call slip requests that have not yet been printed are printed 
consecutively in the order in which they are displayed.  See Sort Pending 
Requests by on page 4-3 for more information about sort order.

Each call slip request prints on a separate page.

NOTE:
File>Print>New is enabled only if there are new call slip requests that have not 
yet been printed.

The procedure for printing all call slip requests is shown in Procedure 3-5, Printing 
All Call Slip Requests, on page 3-8.
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Procedure  3-5.  Printing All Call Slip Requests

Use the following to print all call slip requests.

1. Click the Pending tab.

2. Select Print from the File menu.

3. Select All from the cascading menu. 

Result: All of the call slip requests on the Pending tab are printed consecutively 
in the order in which they are displayed.  See Sort Pending Requests by on 
page 4-3 for more information about sort order.

Each call slip request prints on a separate page.

Filling a Call Slip Request

A call slip request may be processed whether or not it has been printed. When a 
call slip request is processed from the Pending tab, the request is either filled, not 
filled or reassigned. (Reassigned is described in more detail in Reassign Request 
on page 3-18.)

What it means to fill a pending call slip request may vary depending on the Call 
Slip Print Group being processed and how that Call Slip Print Group is configured 
in the System Administration module.

When a request is processed but not filled, the request is assigned a No Fill 
Reason such as Damaged Materials (DM), Not Found (NF), or Wrong Location 
(WL).  See “Call Slip (Closed Stacks)” in the System-Wide Configuration section 
of the Voyager System Administration User’s Guide for more information.

The procedure for processing a pending call slip request using fill and no fill 
options is shown in Procedure 3-6, Processing a Pending Request Using Fill / No 
Fill Options, on page 3-8.

Procedure  3-6.  Processing a Pending Request Using Fill / No Fill Options

Use the following to process a pending call slip request.
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1. Select the request to be processed from the Pending tab.

Result: This highlights the request and makes it active.

2. Select the appropriate option to fill or no fill the pending call slip request using one of 
the following methods.

• Select from the drop-down list at the bottom of the Pending tab

• Select from the Edit menu

• Right-click the call slip request and select from the list provided

Result: This identifies how to process the pending request.

3. (Optional) Enter Reply Note text, up to 100 characters, to the requester.  This can 
be done dynamically for each individual call slip request.

Result: The Reply Note displays as part of email sent to requesters of filled and 
non-filled call slip requests. The Reply Note also displays in the Pending 
Requests Area of the WebVoyáge Patron Information Page for non-filled requests.

4. Click the Process button.

Result: The request transfers from the Pending tab to the History tab. The 
History tab displays all of the requests that have been processed during the 
current call slip session.

Use the Unprocess button to undo requests that have processed during the 
current call slip session. See Figure 3-13.

NOTE:
When a Call Slip Dæmon session is ended/exited, the History tab is cleared for 
the next call slip processing session.  Unprocess works only during a current 
session.

5. (Optional) Link an item to the call slip request.

Result: If a request that is not linked to an item is processed, the Link Item dialog 
box displays. See Link Item to Request on page 3-10 for more information.

The Link Item dialog box also displays anytime an attempt is made to process 
and fill a call slip request if the Force Item Search on Process check box in 
Preferences is checked. See Preferences on page 4-1 for more information about 
the Force Item Search on Process check box.
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Also, if a call slip request is linked to an existing item that does not have a 
barcode, a barcode can be added to the item before processing the call slip 
request. See Adding a Barcode to a Requested Item on page 3-14 for more 
information.

Link Item to Request

Your library may allow patrons in OPAC to submit call slip requests that are not 
linked to existing items. For those requests to be filled in Call Slip Dæmon, they 
must be linked to an existing item or to a new item that is created.  This capability 
is available with Call Slip Dæmon.

Additionally, Call Slip Dæmon allows one to change the item to which any call slip 
request is linked.  Perhaps staff needs to link a different copy of the item to the call 
slip request.  Call Slip Dæmon allows one to override the item that is associated 
with a request and link a different item to the request.

The Link Item dialog box (see Figure 3-6) displays in the following situations.

• Link Item to Request from the Edit menu is selected.

• Ctrl+L is entered.

• An attempt is made to fill a request that is not linked to an item. 

NOTE:
The Link Item dialog box also displays when the Force Item Search on Process 
check box is checked in Preferences and an attempt is made to process and fill a 
call slip request.

The procedure for linking an existing item to a Call Slip request is shown in 
Procedure 3-7, Linking Existing Item to Call Slip Request, on page 3-10.

Procedure  3-7.  Linking Existing Item to Call Slip Request

Use the following to link an item to a call slip request.

1. Select the call slip request that you want to link to an item on the Pending tab.

Result: This highlights the request to be processed.

2. Select Link Item to Request from the Edit menu, press Ctrl+L, or right-click the 
mouse on the call slip request and select Link Item to Request.
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Result: The Link Item dialog box displays. See Figure 3-6.

Figure 3-6. Call Slip Dæmon Link Item Dialog Box

3. Enter or scan the barcode of the item to link to the call slip request in the Barcode 
field. 

(Or click Search By Bib and follow the steps in Procedure 3-10, Select Another 
Item, on page 3-17.)

Result: This identifies the item to link to the pending request.

NOTE:
If the barcode entered is the same as the barcode associated with the request, the 
request processes automatically and moves to the History tab.

4. Click the Search button

Result: The Link Item dialog box expands to include a search results box. See 
Figure 3-7.

Figure 3-7. Call Slip Dæmon Link Item Dialog Box Expanded
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If the barcode that is entered is associated with any items, the titles of those items 
display in the search results box. The <Create New Item> command also 
displays in the search results box. This command may display differently as a 
result of local customizing.  NewItem= Variable on page 4-17 for more 
information.

If the barcode that is entered is not associated with any existing items, only the 
<Create New Item> command displays in the search results box.

5. Click one of the existing items. 

(Or click Search By Bib and follow the steps in Procedure 3-10, Select Another 
Item, on page 3-17.)

Result: This highlights a specific item to be selected for the pending call slip 
request.

6. Click Process.

Result: The call slip request is linked and transferred from the Pending tab to the 
History tab. 

Call slip requests processed during the call slip session remain on the History tab 
until the end of the call slip session.

NOTE:
You can unprocess a call slip request by selecting the request on the History tab 
and clicking the Unprocess button.  If an existing item is linked to a call slip 
request, unprocessing the call slip request unlinks the call slip request and returns 
the call slip request to the Pending tab in its original state.

The procedure for creating a new item link to a Call Slip request is shown in 
Procedure 3-8, Creating a New Item to Link to a Call Slip Request, on page 3-12.

Procedure  3-8.  Creating a New Item to Link to a Call Slip Request

Use the following to create a new item to link to a call slip request.

1. Select the call slip request that you want to link to an item on the Pending tab.

Result: This highlights the request to be processed.
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2. Select Link Item to Request from the Edit menu, press Ctrl+L, or right-click the call 
slip request; and select Link Item to Request.

Result: The Link Item dialog box displays. See Figure 3-6.

3. Enter or scan the barcode of the item to link to the call slip request in the Barcode 
field.

Result: This identifies the item to link to the pending call slip request.

4. Click the Search button

Result: The Link Item dialog box expands to include a search results box. See 
Figure 3-7.

5. Click the <Create New Item> row in the search results box.

Result: This highlights the <Create New Item> row .

6. Click Process.

Result: The newly created item is linked to the pending call slip request.

NOTE:
It is possible to create a new item with a duplicate barcode. The new item created 
has the same barcode as the one displayed on the expanded Link Item dialog 
box. If existing items are displayed on the Link Item dialog box and <Create New 
Item> is selected, the newly-created item receives the same barcode as the other 
items. There is no warning if the new item created has the same barcode as 
existing items.

7. (Optional) Click Yes or No to respond to a verification message. The verification 
message only displays if the Verify Create New Item or Add Barcode process 
option is selected in Preferences. See Figure 3-8.
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Figure 3-8. Verification Message for Create New Item

Result: The call slip request is transferred from the Pending tab to the History 
tab. 

The call slip requests processed during the call slip session remain on the History 
tab until the end of the call slip session.

NOTE:
One can unprocess a call slip request by selecting the request on the History tab 
and clicking the Unprocess button.  If a new item record is created and linked to a 
call slip request, unprocessing that call slip request unlinks the call slip request 
from the newly-created item, deletes the newly-created item, and returns the call 
slip request to the Pending tab in its original state.

It is possible for a call slip request to be linked to an existing item that does not 
have a barcode. Call Slip Dæmon allows one to add a barcode to an item before 
processing the call slip request.

The procedure for adding a barcode to a requested item is shown in Procedure 3-
9, Adding a Barcode to a Requested Item, on page 3-14.

Procedure  3-9.  Adding a Barcode to a Requested Item

Use the following to add a barcode to a requested item that does not have a 
barcode.

1. Select the call slip request on the Pending tab.

Result: This highlights the request and makes it active.
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2. Select Link Item to Request from the Edit menu, press Ctrl+L, or right-click the call 
slip request; and select Link Item to Request.

Result: The Link Item dialog box displays. See Figure 3-6.

3. Enter or scan the barcode to be added into the Barcode field.

Result: This identifies the barcode to be added.

4. Click the Search button.

Result: The Link Item dialog box expands to include a search results box, and 
the <Add Barcode to Item> command displays. See Figure 3-9.  This command 
may display differently as a result of local customizing.  See AddBarcode= 
Variable on page 4-18 for more information.

If the barcode entered is associated with any items, the titles of those items also 
display in the search results box.

Figure 3-9. Call Slip Dæmon Link Item Dialog Box - Expanded

5. Click the <Add Barcode to Item> command.

Result: This identifies that the barcode is to be added to the item.

6. Click the Process button.

Result: The barcode is added to the linked item. The call slip request is 
processed and transferred from the Pending tab to the History tab.
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7. (Optional) Click Yes or No to respond to a verification message.  The verification 
message only displays if the Verify Create New Item or Add Barcode process 
option is selected in Preferences.

Result: This steps confirms or cancels the request to add a barcode.

NOTE:
One can unprocess a call slip request by selecting the request on the History tab 
and clicking the Unprocess button. Unprocessing a call slip request that contains 
a newly-added barcode deletes the barcode from the linked item and returns the 
call slip request to the Pending tab in its original state.

The call slip requests processed during the call slip session remain on the History 
tab until the end of the call slip session.

Select Another Item

The Call Slip module provides the option for the Call Slip operator to select 
another item for an existing call slip request. See Figure 3-10.

Figure 3-10. Select another item (Edit menu)  

The Call Slip operator may choose to select another item attached to the same 
bibliographic record or may select an item attached to an entirely different 
bibliographic record.

This feature displays a list of all items attached to the bibliographic record with 
which the call slip request is associated.  

The procedure for selecting another item is shown in Procedure 3-10, Select 
Another Item, on page 3-17.
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Procedure  3-10.  Select Another Item

Use the following to select another item for a pending request.

1. Highlight the pending call slip request to which you want to select another item.

Result: The call slip request to which a new item is to be attached is identified.

2. Click Edit (or right click highlighted request).

Result: This displays the Edit options.

3. Click Select another item from this Bib.

Result: The Link Item dialog box for Select another item from this Bib 
displays. See Figure 3-11.

Figure 3-11. Link Item dialog box for Select another item from this Bib

NOTE:
If there are no additional items associated with the bibliographic record for the call 
slip request, an information message displays.  See Figure 3-12.
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Figure 3-12. No Other Items for Bib informational message

4. Click the item record to be selected from the list.

Result: This highlights the item to be linked.

5. (Optional) Click Search by Barcode to identify a different bibliographic record and 
item to select for the call slip request and complete the item linking using 
Procedure 3-7, Linking Existing Item to Call Slip Request, on page 3-10.

Result: This displays the Link Item dialog box as seen in Figure 3-6.

6. Click Link Item and Process Request, click Link Item, or click Cancel.

Result: The substitute item is linked to the request and processed, simply linked 
and displayed on the Pending tab, or the transaction is cancelled.

TIP:
Double-click the item to link and fulfill the request in one step.

Reassign Request

The Call Slip Reassign Request feature permits staff using Call Slip Dæmon to 
direct a call slip request to another Call Slip queue before the request has been 
processed. This option exists for call slip requests with or without items linked to it.

Once reassigned, the call slip displays in the new queue specified by the Call Slip 
Dæmon operator and is automatically removed from the reassigning queue.

After a call slip is reassigned, the status of the Call Slip request that displays in the 
Circulation module and the WebVoyáge module is Reassigned.  The Reassigned 
status behaves the same as the Accepted status.
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The procedure for reassigning call slip requests is shown in Procedure 3-11, Call 
Slip Request Reassignment.

Procedure  3-11.  Call Slip Request Reassignment

Use the following to reassign a pending call slip request.

1. Highlight the pending call slip request to be reassigned.

Result: The call slip request to be reassigned is identified.

2. Click Edit (or right click highlighted request).

Result: This displays the Edit options that include the Reassign Request option.

NOTE:
Reassign Request is an active option for individual call slip requests.  When you  
highlight multiple call slip requests, this option is not available.

3. Click Reassign Request.

Result: A list of Call Slip queues displays.

4. Select the Reassignment Queue, and click OK or Cancel.

Result: The call slip request is reassigned to the new Call Slip Queue or the 
operation is cancelled. 

When reassigned, the call slip request displays in the reassigned queue with the 
note (REASSIGNED).  See Figure 3-13.

Figure 3-13. Call Slip Reassigned Status Message



3-20  

Call Slip Dæmon User’s Guide

! IMPORTANT:
Once a call slip request is reassigned, this action cannot be unprocessed 
as with other requests that display on the History tab.  A reassignment 
action immediately transfers a call slip request to the specified queue, and 
it does not display on the History tab of the reassigning queue.

NOTE:
If a call slip is reassigned to a Call Slip queue that is set to automatically print call 
slips, the (REASSIGNED) status is immediately replaced with the printed status.

Call Slip Reassignment History

The system tracks the history of call slip requests that are reassigned and 
provides the ability to print and view this reassignment information.  The benefit of 
tracking this information is to avoid reassigning a call slip request to a queue 
where it has already been.

The procedure for viewing call slip reassignment history is shown in Procedure 3-
12, View Call Slip Reassignment History.

Procedure  3-12.  View Call Slip Reassignment History

Use the following to view call slip reassignment history.

1. Highlight the pending call slip request whose history you want to view.

Result: The call slip request whose history is to be viewed is identified.

2. Click Edit.

Result: This displays the Edit options that include the View Reassignment 
History option. See Figure 3-10.

NOTE:
View Reassignment History is an active option for individual call slip requests.  
When you highlight multiple call slip requests, this option is not active.

3. Click View Reassignment History.
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Result: The history for the selected call slip request displays. (The history 
displays in reverse chronological order.) See Figure 3-14.

Figure 3-14. View Reassignment History dialog box

NOTE:
If there is no reassignment history, the system displays No History Items Found.

4. Click OK.

Result: This closes the open history dialog box.

Displaying Processed Requests 
(History Tab)

From the History tab, you can do the following.

• View the list of call slip requests that have been processed during the 
current Call Slip Dæmon session

• Unprocess call slip requests that have been processed during the current 
Call Slip Dæmon session

View the List of Processed Call Slip Requests

To view the list of call slip requests that you have processed during your current 
call slip session, click the History tab. The History tab displays the Request ID 
number and Request Action such as Filled, Not Filled, or Error of each processed 
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call slip request. The processed requests remain on the History tab until the Call 
Slip Dæmon session is ended by exiting Call Slip Dæmon or until the request(s) is 
unprocessed.

There are numerous reasons why one may want to unprocess a call slip request 
that is processed during the current Call Slip Dæmon session.  For example, the 
wrong call slip request may have been processed, a request may have been 
processed with the wrong Fill Reason, or a call slip request may have been linked 
to the wrong item.

Procedure  3-13.  Unprocessing a Processed Call Slip Request

Use the following to unprocess a call slip request.

1. Click the History tab.

Result: The processed call slip requests display.

Figure 3-15. Call Slip Dæmon History tab

2. Click the processed call slip request that needs to be unprocessed.

Result: This identifies the call slip request to be unprocessed.
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NOTE:
The Unprocess button is enabled only if one of the processed call slip requests is 
highlighted on the History tab.

3. Click the Unprocess button.

Result: This deletes the request from the History tab and transfers the request 
back to the Pending tab.

NOTE:
If you linked an existing item to a call slip request, unprocessing the call slip 
request unlinks the call slip request and returns that call slip request to the 
Pending tab in its original state.

If you have created a new item record and linked it to a call slip request, 
unprocessing that call slip request unlinks the call slip request from the newly-
created item, deletes the newly-created item, and returns the call slip request to 
the Pending tab in its original state.

If you added a barcode to an item that was linked to a call slip request, 
unprocessing the call slip request deletes the newly-created barcode from the 
linked item and returns the call slip request to the Pending tab in its original state. 

See Link Item to Request on page 3-10 for more information about linked items.
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Overview

Voyager Call Slip Dæmon provides many options to tailor the system to your 
needs. This tailoring is handled through the Preferences function located in the 
File menu and through the options specified in the callslip.ini file. The 
following sections describe in detail the options available and how to customize 
them to meet your requirements.

Preferences

You can define preferences for Call Slip Dæmon by selecting Preferences from 
the File menu to display the Preferences dialog box. See Figure 4-1. In the 
Preferences dialog box, you can specify the following.

• Select automatic Call Slip Dæmon features

• Define how automatic features are to perform

• Define how certain aspects of Call Slip Dæmon display

• Define certain print options with which a call slip request is printed

The following options in the Preferences dialog box automatically update the 
[Preferences] stanza of the callslip.ini file.

• Update and Email Send Interval (1-99 minutes)

• Use alert sound
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• Automatically print new requests

• Sort Pending Requests by

• Default Find Method

Additionally, the Printer Options information in the Preferences dialog box 
automatically updates the [Print Options] stanza of the callslip.ini 
file.

Figure 4-1. Call Slip Dæmon Preferences dialog box

New Request Options

Under New Request Options, you can specify the following.

• The frequency with which the system automatically updates the Pending 
tab

• The use of an audio alert for new pending call slip requests received

• The automatic printout of new call slip requests
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Update and Email Send Interval 

Use the Update and Email Send Interval to specify the number of minutes from 
1 to 99 that elapses before the Call Slip Dæmon polls the server for new call slip 
requests and checks the queue for emails to be sent.  When the Update and 
Send Email Interval elapses, the server is automatically queried for new pending 
call slip requests and checked for new emails to distribute. Subsequently, a list of 
all new pending call slip requests is returned to the Pending tab, and email 
messages are sent.

The setting for this option depends on the number of requests you process and 
your procedures. If your library retrieves requests one at a time as they are 
received, the interval specified should be short so that individual requests display 
sooner. If you retrieve requests in a batch the interval does not need to be as 
short.

NOTE:
The Update and Send Email Interval option works in conjunction with the 
Number of Emails to cache before sending option. See Email Options on 
page 4-6. Email messages are sent when one of these parameters is met.

Use Alert Sound

Use the Use alert sound to specify if an audio signal is to be used to notify staff 
when new call slip requests are placed on the Pending tab. After the Use alert 
sound check box is selected, use the Select Sound button to specify the location 
of the audio file to be used. To confirm the options specified, use the Test button 
to test the audio file selected.

Automatically Print New Requests

Use the Automatically print new requests option to have Call Slip Dæmon 
automatically print new pending call slip requests as they are sent to the Pending 
tab.

Sort Pending Requests by

Use the Sort Pending Requests by option, to determine the sort order of the call 
slip requests on the Pending tab. The available sort choices are as follows:

• Request ID

• Call Number

• Title
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Select the sort order that best matches your requirements. You may want to set 
the sort order to match your shelf order if call slip requests are processed in 
batches.

Default Find Method

Use the Default Find Method option to enhance the workflow processing of call 
slip requests. This option determines the default cursor placement in the Find 
Request ID field or the Find Item Barcode field on the Pending tab. Select the 
most common search type as the default, by Request ID or by Item Barcode.

Process Options

Preferences provides two Process Options.

• Force Item Search on Process

• Verify Create New Item or Add Barcode

Force Item Search on Process

Use the Force Item Search on Process option to add a verification step to the 
call slip processing procedure. When this option is selected, Call Slip Dæmon 
displays the Link Item dialog box after the call slip operator has selected a 
request and clicks Process. This forces the call slip operator to enter a barcode in 
order to complete processing of the request. This additional step ensures that the 
call slip operator is processing the correct request with the correct item.

If the barcode entered on the Link Item dialog box matches the barcode tied to 
the call slip request, the request processes and is automatically moved to the 
History tab when the Search button is clicked.

NOTE:
When the Force Item Search on Process option is not selected, the Link Item 
dialog box functions somewhat differently. After you enter the barcode and click 
the Search button, the expanded Link Item dialog box displays.  Processing of 
the call slip request is not yet complete.

If the barcode that the call slip operator types or scans on the Link Item dialog 
box is not the same as the barcode tied to the call slip request, the expanded Link 
Item dialog box displays enabling the operator to use the Link Item functions to 
continue processing the call slip request.  See Link Item to Request on page 3-10 
for additional information.



 4-5

Chapter 4: Customizing Your System

Verify Create New Item or Add Barcode

Use the Verify Create New Item or Add Barcode option to force a verification 
message to display when a call slip operator attempts to create a new item or add 
a barcode to an existing item from the Link Item dialog box.  See Figure 3-8 on 
page 3-14.

If this option is not selected, a verification message will not display when a call slip 
operator attempts to create a new item or add a barcode to an existing item from 
the Link Item dialog box.

See Creating a New Item to Link to a Call Slip Request on page 3-12, and see 
Adding a Barcode to a Requested Item on page 3-14 for additional information.

Printer Options

There are three Printer Options.

• Tab Width

• Standard Font

• Alternate Font

Tab Width

The Tab Width option sets the spacing, in inches, for the tab command used in 
the [Print Template] stanza of the callslip.ini file.

Standard Font

Use the Standard Font option to select the standard font that is used to print call 
slips. Click the ellipsis to display font choices from which to select.

Alternate Font

Use the Alternate Font option to select an alternate font to be used to print call 
slips. Click the ellipsis to display font choices from which to select. As in Figure 4-
1, an alternate font, Barcode 3 of 9 for example, can be selected to print barcode 
information on the call slip request printout.

The call slip operator can use the printed barcode on the call slip request printout 
to scan the barcode into the Find Item Barcode field on the Pending tab. This 
will aid in more quickly processing call slip requests. See Figure 4-7 on page 4-31 
for an example of a barcode printed on a call slip request printout.
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To learn more about using the alternate font in the call slip print template in the 
[Print Template] stanza of the callslip.ini file, see Defining the 
Callslip.ini File on page 4-7.

Email Options

Use the Number of Emails to cache before sending option within Email 
Options to group the distribution of emails into a batch to be sent at one time.  
Email messages to be sent queue in cache until the number specified in this 
option is reached.  When the setting is 0 (zero), each email is sent as it is created.  
The maximum setting for Number of Emails to cache before sending is 100.  
Any email messages remaining in cache are sent when Call Slip Dæmon is 
exited.

NOTE:
The Number of Emails to cache before sending option works in conjuction with 
the Update and Send Email Interval option (see Update and Email Send Interval 
on page 4-3).  

! IMPORTANT:
Email messages are sent when one of these parameters (Number of 
Emails to cache before sending option or Update and Send Email Interval 
option) is met.

Regular Requests

Use the options on the Regular Requests tab to indicate when email requests 
are to be sent and specify the content of the email subject line for call slip 
requests in a regular (non-Universal Borrowing) environment.

Select Send email for filled requests and/or Send email for unfilled requests 
to specify if emails are to be sent for filled requests and/or unfilled requests.  Enter 
the subject line content up to 80 characters in length for each email type, filled or 
unfilled, that you choose to send.

Universal Borrowing Requests

Use the options on the Universal Borrowing Requests tab to indicate when 
email requests are to be sent and specify the content of the email subject line for 
call slip requests in a Universal Borrowing environment.



 4-7

Chapter 4: Customizing Your System

Select Send email for filled requests and/or Send email for unfilled requests 
to specify if emails are to be sent for filled requests and/or unfilled requests.  Enter 
the subject line content up to 80 characters in length for each email type, filled or 
unfilled, that you choose to send.

Save Preferences

Click the OK button to save the selections you have made and close the 
Preferences dialog box.

Click the Cancel button to close the Preferences dialog box without saving.

Defining the Callslip.ini File

Upon installation, the Voyager Call Slip Dæmon initialization file is located in the 
.../Voyager/misc directory.  Your library may have customized the name of 
the main directory under which Voyager resides.

The callslip.ini file contains the following stanzas.

• [General]

• [Preferences]

• [Print Options]

• [Routing Slip Print Template]

• [Call Slip Print Template]

• [Email Options]

• [Email Template Filled]

• [Email Template UnFilled]

• [Email Template UB Filled]

• [Email Template UB UnFilled]

The [Preferences] and [Print Options] stanzas do not need to be 
configured from within the callslip.ini file. These stanzas directly reflect 
configuration selections that are made from the File>Preferences menu options 
in Call Slip Dæmon.

The information generated from the [Call Slip Print Template] stanza 
can be printed and used as a pull slip for patron requests.

The following stanzas determine the content and format of information printed as 
a result of processing call slip requests in Call Slip Dæmon.
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• [Routing Slip Print Template]

• [Call Slip Print Template]

• [Email Template Filled]

• [Email Template UnFilled]

• [Email Template UB Filled]

• [Email Template UB UnFilled]

Callslip.ini File Example

Figure 4-2 is an example of the callslip.ini file.
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Line#

1 [General]

2 LocationCode=

3 NewItem=<Create New Item>

4 AddBarcode=<Add Barcode to Item>

5

6 [Preferences]

7 Alert=1

8 AutoPrint=0

9 SortPending=R

10 DefaultFind=0

11 Interval=10

12 ForceSearch=0

13 VerifyNewAdd=0

14 Sound=

15

16 [Print Options]

17 FontName=Times New Roman

18 FontSize=12

19 TabWidth=0.5

20 AlternateFontName=Barcode 3 of 9

21 AlternateFontSize=14

22

23 [Routing Slip Print Template]

24 Route Item To:

25 \

26 \

27 Library:   \F600

28 Location:  \F601

29 Address:   \F602

30 \F603

31 \F604

Figure 4-2. Callslip.ini file example
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32 \F605

33 \F606

34 \F607, \F608 \F609

35 \F610

36

37

38 [Call Slip Print Template]

39 Patron Barcode:\T\A*\F525*\a

40 \

41 \

42 \

43 Call Number:\T\F301

44 Author:\T\F203

45 Title:\T\F202

46 Location:\T\F411

47 Patron Name:\T\F509

48 Enumeration:\T\F409

49 Request date:\T\F102

50 Pickup Location:\T\F105

51 \

52 Promote Request History:

53 \F530:(Date=Promote Date:,Database=Database 
Name:,Cluster=Cluster Name:)

54 \

55 \

56 Reassignment History:

57 \F540:(Date=Date,From=From Print 
Group,By=Operator)

58 \

59 Reply to Reader:         Item is not 
available...

60 \F901

61 \

Line#

Figure 4-2. Callslip.ini file example
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62 \

63 \A\F101\a

64 \

65 \

66 \

67 (Request number)

68 \

69 \S24\F509\s

70

71 [Email Options]

72 CacheCount=5

73 RegFilledActive=Y

74 RegFilledSubject=This item may be picked up 
today.

75 RegUnFilledActive=Y

76 RegUnFilledSubject=This item will not be 
available until next month.

77 UBFilledActive=Y

78 UBFilledSubject=This item may be picked up 
in 3 days.

79 UBUnFilledActive=Y

80 UBUnFilledSubject=This Item is no longer 
available.

81

82

83 [Email Template Filled]

84 \

85 Dear: \F509

86 \

87 The Item you requested has been retrieved 
and is now available.\

88 \

89 Call Number: \F301

90 Author: \F203

Line#

Figure 4-2. Callslip.ini file example



4-12  

Call Slip Dæmon User’s Guide

91 Title: \F202

92 Location: \F411

93 Enumeration: \F409

94 Request date: \F102

95 \

96 \

97 Note from the Library:\

98 \F110

99 \

100 If you need to reply to this message, reply 
to: xxx@yyy.zzz\

101 \

102 \

103 \

104 (Request number)\

105 \

106 \F101

107 \

108

109 [Email Template UnFilled]

110 \

111 Dear: \F509

112 \

113 The Item you requested is not available.\

114 \

115 Reason: \F900

116 \

117 Call Number: \F301

118 Author: \F203

119 Title: \F202

120 Location: \F411

121 Enumeration: \F409

122 Request date: \F102

Line#

Figure 4-2. Callslip.ini file example
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123 \

124 \

125 Note from the Library:

126 \F110

127 \

128 If you need to reply to this message, reply 
to: xxx@yyy.zzz\

129 \

130 \

131 \

132 (Request number)\

133 \

134 \F101

135 \

136

137

138 [Email Template UB Filled]

139 \

140 Dear: \F509

141 \

142 The Item you requested from another library 
has been retrieved and is now in transit.\ 

143 \

144 Call Number: \F301

145 Author: \F203

146 Title: \F202

147 Location: \F411

148 Enumeration: \F409

149 Request date: \F102

150 \

151 \

152 Note from the Library:\

153 \F110

Line#

Figure 4-2. Callslip.ini file example
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154 \

155 If you need to reply to this message, reply 
to: xxx@yyy.zzz\

156 \

157 \

158 \

159 (Request number)\

160 \

161 \F101

162 \

163

164 [Email Template UB UnFilled]

165 \

166 Dear: \F509

167 \

168 The Item you requested from another library 
is not available.\ 

169 \

170 Reason: \F900

171 \

172 Call Number: \F301

173 Author: \F203

174 Title: \F202

175 Location: \F411

176 Enumeration: \F409

177 Request date: \F102

178 \

179 \

180 Note from the Library:\

181 \F110

182 \

183 If you need to reply to this message, reply 
to: xxx@yyy.zzz\

Line#

Figure 4-2. Callslip.ini file example
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General Stanza

The [General] stanza stores the location code and the label content for the 
new item and add barcode commands. See lines 1 through 4 in Figure 4-2.  The 
following information provides a detailed description of the variables in the 
[General] stanza.

LocationCode= Variable  

The first time Voyager Call Slip Dæmon is accessed a dialog box listing the call 
slip groups created in Voyager System Administration displays.  See Figure 1-3 
on page 1-4.  When the appropriate call slip group is selected, the group name is 
saved in the LocationCode= variable in the [General] stanza of the 
callslip.ini file.

Storing the LocationCode= variable in callslip.ini conveniently saves 
the call slip operator an extra step at login. However, if the call slip group needs to 
be changed for a particular workstation, simply delete the variable specified after 
LocationCode= in the callslip.ini file stored on that workstation.  The 
next time Voyager Call Slip Dæmon is run on that workstation the Select Call Slip 
Group dialog box displays the list of call slip groups as defined in Voyager System 
Administration from which to select.

NOTE:
The LocationCode= variable can be entered manually.  However, allowing the 
system to store the variable avoids any possible errors that may occur by doing it 
manually. Entering incorrect information in the LocationCode= variable causes 
Voyager Call Slip Dæmon to fail to run.

The following approach is recommended if the call slip group needs to be selected 
each time Voyager Call Slip Dæmon is run.

184 \

185 \

186 \

187 (Request number)\

188 \

189 \F101

190 \

Line#

Figure 4-2. Callslip.ini file example
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• Delete the value that is entered for the LocationCode= variable in the 
[General] stanza of the callslip.ini file and save the file.

• Set the callslip.ini file to read-only.

This causes the Call Slip Group dialog box to display for each login session.  
This is a useful technique to use if you plan to use a single workstation for 
processing call slip requests for multiple call slip groups.

NOTE:
Each time Voyager Call Slip Dæmon is run, call slip Preferences resets to the 
options specified in the read-only version of callslip.ini.

Procedure  4-1.  Saving Callslip.ini As Read-Only

Use the following to save the callslip.ini file as read-only.

1. Right-click the callslip.ini file.

Result: The File menu displays.

NOTE:
Upon installation, the callslip.ini file is located in the .../Voyager/
misc/ directory.  Your library may have customized the name of the main 
directory under which Voyager resides.  Check with your system administrator for 
your location’s directory path structure.

2. Select Properties from the File menu.

Result: The callslip.ini Properties dialog box displays.
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Figure 4-3. callslip.ini Properties dialog box

3. Select the Read-only option, and click Apply.

Result: This sets the file to read-only mode.

4. Click Close to exit the callslip.ini Properties dialog box.

Result: This saves the selection and closes the dialog box.

NewItem= Variable  

The NewItem= variable provides the text that displays in the expanded Link Item 
dialog box for the command that creates new items. Callslip.ini has a 
default setting of NewItem=<Create New Item>. See Figure 4-4 for an 
example of how this displays on the expanded Link Item dialog box. For another 
example, see Figure 3-7.

NOTE:
If nothing is entered for the NewItem= variable, the create new item command 
displays a blank line in the expanded Link Item dialog box. See Creating a New 
Item to Link to a Call Slip Request on page 3-12 for more information.
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Figure 4-4. Link Item dialog box - Create New Item command displayed

AddBarcode= Variable  

The AddBarcode= variable provides the text that displays in the expanded Link 
Item dialog box for the command that creates new barcodes. Callslip.ini 
has a default setting of AddBarcode=<Add Barcode to Item>. See 
Figure 4-5 for an example of how this displays on the expanded Link Item dialog 
box.  For another example, see Figure 3-9.

NOTE:
If nothing is entered for the AddBarcode= variable, the add barcode to item 
command displays a blank line in the expanded Link Item dialog box. See Adding 
a Barcode to a Requested Item on page 3-14 for more information.

Figure 4-5. Link Item dialog box - Add Barcode command displayed
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Preferences Stanza

The [Preferences] stanza of the callslip.ini file directly reflects the 
choices made in the Preferences dialog box in Voyager Call Slip Dæmon. This 
information is automatically saved in the callslip.ini file when it is changed 
in Voyager Call Slip Dæmon. The [Preferences] stanza can be manually 
edited.  However, you may find it more expedient to use the Preferences dialog 
box in Voyager Call Slip Dæmon instead, and let the system automatically save 
the information to the callslip.ini file.

Print Options Stanza

The [Print Options] stanza of the callslip.ini file directly reflects the 
choices made in the Print Options group box on the Preferences dialog box in 
Voyager Call Slip Dæmon. This information is automatically saved in the 
callslip.ini file when it is changed in Voyager Call Slip Dæmon. The 
[Print Options] stanza can be manually edited.  However, you may find it 
more expedient to use the Print Options group box on the Preferences dialog 
box in Voyager Call Slip Dæmon instead, and let the system automatically save 
the information to the callslip.ini file.

NOTE:
The [Print Options] stanza contains specifications that are used by the 
template stanzas that provide printed output.

Email Options Stanza

The [Email Options] stanza of the callslip.ini file directly reflects the 
choices made in the Preferences dialog box in Voyager Call Slip Dæmon. This 
stanza stores the selections that specify the following.

• Is email to be sent Yes (Y) or No (N)

• Content of the email subject line

• Number of emails to queue before sending (cache count)

This information is automatically saved in the callslip.ini file when it is 
changed in Voyager Call Slip Dæmon. The [Email Options] stanza can be 
manually edited. However, you may find it more expedient to use the Preferences 
dialog box in Voyager Call Slip Dæmon instead, and let the system automatically 
save the information to the callslip.ini file.
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Template Stanzas

The template stanzas define the output for a variety of requirements. The setup of 
the following template stanzas share some common features.

• [Routing Slip Print Template]

• [Call Slip Print Template]

• [Email Template Filled]

• [Email Template UnFilled]

• [Email Template UB Filled]

• [Email Template UB UnFilled]

In addition to the static content that is stored in the templates, there are also 
action codes and field codes that can be used to tailor the content of the template. 
See Callslip.ini File Example on page 4-8 for sample templates in the 
callslip.ini file.

When an operator selects Print from the File menu in Call Slip Dæmon, detailed 
information associated with the selected call slip request prints according to how 
the [Print Template] stanza of the callslip.ini file is set up. The print 
template can be completely customized. Whatever you type in the [Print 
Template] stanza appears on the call slip request printout. In addition, there are 
action codes that you can use in the [Print Template] stanza to change 
how the information displays on the printout, and certain field codes that you can 
enter after the \F action code to specify the field information that is to be printed.

Action Codes

Action codes are provided for formatting the output of the templates. Table 4-1 
provides a list of action codes and a description of their functions.

Table 4-1. Action Codes

Action Code Description

\ Prints a blank line.

\A Starts alternate font (as specified in the Preferences dialog 
box).

\a Ends alternate font.

\B Starts bold.

\b Ends bold.

\I Starts italic.
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See Figure 4-6 on page 4-30 for an example of how to implement action codes.

Printed information prints using the font and font size specified in the Standard 
Font field on the Preferences dialog box in Voyager Call Slip Dæmon.

Field Codes

Field codes identify the information in the templates that is to be output for emails, 
call slip printouts, and routing information. Field codes work in combination with 
the \F action code to produce the desired result. 

In addition to the predefined field codes, any MARC bibliographic field and 
subfields (with the exception of control fields 001 - 009) can be printed.  See 
MARC Variable Data on page 4-23 for more information.

Table 4-2 provides a list of predefined field codes and a description of the field 
content.

\i Ends italic.

\U Starts underline.

\u Ends underline.

\S Starts new font size (a two-digit size must follow \S).

\s Ends new font size.

\T Inserts a tab.

\F Inserts field data (a three-digit field code must follow \F).

Table 4-2. Predefined Field Codes

Field Code Description

100 Call Slip Print Group (Queue)

101 Request ID

102 Request Date & Time

105 Pickup Locations for local call slip requests

NOTE:
If 105 in a Universal Borrowing situation is used for a call slip 
request with a pickup location at a remote database from the 
holding library, the pickup location is left blank.

Table 4-1. Action Codes

Action Code Description
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109 User Comment

110 Call Slip Reply Note

201 Title Brief

202 Title Long

203 Author

301 Call Number

401 Item Barcode

402 Enumeration

403 Chronology

404 Year

407 Copy Number

409 Copy Information (includes Enumeration, Chronology, Year, 
Caption, Free Text, and Copy Number all on one line)

411 Item Location

504 Patron Title

505 Patron SSN

506 Patron Institution ID

509 Formatted Name

510 Address Line 1

511 Address Line 2

512 Address Line 3

513 Address Line 4

514 Address Line 5

515 City

516 State/Province

517 Zip/Postal Code

518 Country

519 Phone Number

525 Patron Barcode

526 Patron Group Name

Table 4-2. Predefined Field Codes

Field Code Description
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See Figure 4-6 on page 4-30 for an example of how to implement field codes.

MARC Variable Data

Any variable data from MARC bibliographic records can be identified in 
callslip.ini templates and printed (except for the MARC control fields 001-
009). See Table 4-3 for a description of the syntax used with MARC variable data 
in callslip.ini templates.

This capability to use MARC variable data is provided in addition to the set of 
predefined data elements (see Table 4-2) and action codes (see Table 4-1) for use 
in callslip.ini templates.

NOTE:
There are a few predefined data elements such as Call Number, Author, and Year 
that can be generated using either method.  That is, these duplicate predefined 

530 Date (When), Database (Where), Cluster (Which) 

For History of UB (Universal Borrowing) Request Promotions

540 Date (When), From (Where), By (Who) 

For Call Slip Reassignment History

600 UB (Universal Borrowing) Library Name

601 UB (Universal Borrowing) Location Name

602 UB (Universal Borrowing) Address Line 1

603 UB (Universal Borrowing) Address Line 2

604 UB (Universal Borrowing) Address Line 3

605 UB (Universal Borrowing) Address Line 4

606 UB (Universal Borrowing) Address Line 5

607 UB (Universal Borrowing) Address City

608 UB (Universal Borrowing) Address State

609 UB (Universal Borrowing) Address Zip

610 UB (Universal Borrowing) Address Country

900 Call Slip No-Fill Reason

901 No-Fill Reason List

Table 4-2. Predefined Field Codes

Field Code Description
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codes can be used or the MARC variable data syntax can be used in a 
callslip.ini template to generate the same information on the call slip.  

Table 4-3. Syntax for MARC variable data

Character 
Position Character Description

1 - 3 \MB Action code to insert a MARC variable data field.  \MB 
specifies that a data field is to be inserted into the print 
stream from a MARC bibliographic record.

4 Blank space.

5 - 7 ddd Three-digit tag (010 - 999 defined by Ex Libris) representing 
the MARC data field to be inserted into the print stream.  

NOTE:
This excludes MARC control fields 001 - 009.

8 Blank space.

9 0 - 9, |, or X Single digit representing the first MARC indicator for the 
field. Only insert the field into the print stream if the first 
indicator in the MARC field matches this value in the 
callslip.ini template.

NOTE:
A pipe symbol ( | ) in callslip.ini indicates that the field is only 
to be inserted into the print stream if the first indicator in the 
MARC field is blank.

An X in the callslip.ini indicates that no comparison should 
be made with the first indicator in the MARC field.  In this 
syntax, X acts as a wildcard character.

10 0 - 9, |, or X Single digit representing the second MARC indicator for the 
field. Only insert the field into the print stream if the second 
indicator in the MARC field matches this value in the 
callslip.ini template.

NOTE:
A pipe symbol ( | ) in callslip.ini indicates that the field is only 
to be inserted into the print stream if the second indicator in 
the MARC field is blank.

An X in the callslip.ini indicates that no comparison should 
be made with the first indicator in the MARC field.  In this 
syntax, X acts as a wildcard character.

11 Blank space.
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The following is an example of what could be included in a callslip.ini 
template that represents the implementation of the syntax described in Table 4-3.

\MB 650 1X abcd\m

This example specifies the following to the system.

• Search for all instances of the 650 field that are present in the MARC 
record; and subsequently, reject any instances in which the first indicator is 
not equal to 1.

• The X is a wildcard character and indicates that the system is to ignore the 
second indicator value in the 650 fields.

• All instances of subfields a, b, c, and d are to be inserted into the print 
stream for each of the instances of the 650 field in which the first indicator 
is equal to 1.

• The action is terminated by \m.

Formatting the Data

The following are formatting considerations when using MARC variable data 
fields.

• Data from each instance of the MARC field are printed on separate lines.

• Strings of data from multiple subfields are concatenated with a separating 
space.  If the group of concatenated data strings exceeds the available 
print area for a single line, the text is wrapped to the next line.

• Each line of text starts in the same column (position).

• Data from subfield 6 is printed exactly as contained in the MARC record.  
Any special handling indicated in the related 880 field to print alternate 
graphics is ignored.

Error Handling

The following are error-handling considerations when using MARC variable data 
fields.

12..n a - z and/or 
0 - 9

String of 1 - 36 alphanumeric digits designating the MARC 
subfield(s) to be inserted into the print stream.

o - q \m Ends the action code.

Table 4-3. Syntax for MARC variable data

Character 
Position Character Description
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• If there is no data in the variable data field specified as specified in the 
template, nothing is added to the print stream.

• If a control field 001 - 009 is designated in the callslip.ini template, the 
following text is inserted.

*** Unsupported Field Code ***

• If a malformed action code is encountered in the callslip.ini template, the 
following text is inserted.

*** Malformed MARC Field Code ***

Call Slip Reassignment History

To print call slip reassignment history, use the 540 field code in combination with 
the \F action code. This provides historical information for reassigned call slip 
requests.

Example:

\F540:(Date=Date,From=From Print Group,By=Operator)

This example highlights several key points.

• The colon and parentheses are required.

• Date, From, and By are the parameter names

• Each parameter must be followed by the equal sign (=)

• A character string of your choosing follows the equal sign for each 
parameter and is used as a column heading in the printed output.

• The first and second parameter/character string must end with a comma.

• (Optional) The parameters may be arranged in any order. They do not 
need to follow the sequence identified in the example.

Call Slip Promote History

To print call slip promote history, use the 530 field code in combination with the \F 
action code. This provides the history for Universal Borrowing request promotions.

Example:

\F530:(Date=Date,Database=Database Name,Cluster=Cluster 
Name)

This example highlights several key points.
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• The colon and parentheses are required.

• Date, Database, and Cluster are the parameter names.

• Each parameter must be followed by the equal sign (=).

• A character string of your choosing follows the equal sign for each 
parameter and is used as a column heading in the printed output.

• The first and second parameter/character string must end with a comma.

• (Optional) The parameters may be arranged in any order. They do not 
need to follow the sequence identified in the example.

Initiating and Ending Action Codes

All action codes begin with the backslash character. Many of the action codes 
work in pairs starting a function with the uppercase character and ending the 
function with the lowercase character. See Table 4-1 for a list of action codes.

One of the action code pairs is for making content bold. To make template content 
bold, place \B at the beginning of the text to be bold and \b and the end of the 
bolded text. An example of a character string that produces bolded text is as 
follows:

\BPatron Barcode:\b

This character string generates:

Patron Barcode:

Follow the same process to implement other action code pairs to format template 
content, both static or variable content.

Printing Field Information

To print field information, a field code must be entered after the \F action code. 
See Table 4-2 for a list of field codes.

Enter the following information in the template to print the Patron Name field 
stored on the server after the heading Patron Name.

Patron Name:  \F509

If Adam Jones is stored in the Patron Name (Formatted Name) field, this 
character string generates:

Patron Name:  Adam Jones

See Figure 4-6 on page 4-30.
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Printing in the Alternate Font

Use the \A and \a action code pair and the alternate font capability to print 
barcode information.  With the Request ID field code of 101, the following 
character string generates a printed barcode:

\A\F101\a

See Figure 4-6 on page 4-30 and see Figure 4-7 on page 4-31 for an example of 
a template that generates a printed barcode.

The alternate font can be specified by using the Alternate Font option on the 
Preferences dialog box.

To ensure that the printed barcode does not overlap with surrounding information, 
insert blank lines with the backslash character before and after the barcode 
specifications in the template. See Figure 4-6. This improves the scanability of the 
printed barcode.

NOTE:
The barcode font that is included with Voyager is called Barcode 3 of 9.  If the 
library’s scanning device requires start/stop characters for the barcode and 
Barcode 3 of 9 is used, enter asterisks before and after the barcode specification 
in the template such as *\F101*. See Figure 4-6 on page 4-30 for an example of 
the character string required to generate the desired result. If a different barcode 
font is used, read the barcode font’s documentation to determine what start/stop 
character must be used for that font.

Caution:  If bold formatting is used with the barcode, the barcode height prints 
taller and the digits beneath the barcode may not be visible. If italic formatting is 
used with the barcode, the barcode height prints shorter. Test templates to confirm 
that printing generates the desired results.

Changing Font Size

Changing font size within the template content requires one of the pairs of action 
codes, specifically, \S and \s.  In addition the new font size needs to be specified.  
To print certain template content using a different font size, surround the text with 
\S## (where ## is the new font size) at the beginning of the modified text and \s 
at the end of the modified text. See Figure 4-6 on page 4-30 and see Figure 4-7 
on page 4-31 for an example of the usage of \S and \s.
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Inserting a Blank Line

To insert a blank line in printed output, enter a line with only the backslash (\) 
character in the template content. See Figure 4-6 on page 4-30 and see Figure 4-
7 on page 4-31 for an example with blank lines inserted in the text.

Inserting a Tab

To format template content with a tab, use the \T action code.  Enter the \T 
before the information to be indented. The indentation spacing that applies to this 
action code is determined by the Tab Width (Inches) option on the Preferences 
dialog box.

To print the following information:

Reply to Reader:

Damaged material; not available

Enter the following character string in the template:

Reply to Reader:

\T\F901

Example

Figure 4-6 is an example of a template that can be embedded in the 
callslip.ini file.
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Figure 4-7 shows the printed output of a call slip request when the [Call Slip 
Print Template] stanza in Figure 4-6 is used.

Line#

1 [Call Slip Print Template]

2 Call Number: \F301

3 Author: \F203

4 Title: \F202

5 Enumeration: \F409

6 Location: \F411

7 Patron Name: \F509

8 Request Date: \F102

9 \

10 \

11 Reply to Reader:  Item is not available ...

12 \F901

13 \

14 \

15 \

16 \A*\F101*\a

17 \

18 (Request Number)

19 \

20 \S24\F509\s

21

Figure 4-6. Example of [Call Slip Print Template] stanza in the Callslip.ini file
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Figure 4-7. Example of a call slip printout

Call Number: PS3573.A425 C6 1983
Author: Walker, Alice, 1944-
Title: Color Purple /
Enumeration: 
Location: Main Collection
Patron Name: Aura R. Stevens
Request Date: 11/3/98 01:26 PM

Reply to Reader: Item is not available ...
__Damaged
__Lost
__Not Available
__Not Found

????1739403
(Request number)

Aura R. Stevens
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[Print Options] stanza, 4-19
printer options, 4-5
printing

all call slip requests, 3-8
all new call slip requests, 3-7
specific call slip request(s), 3-6

processed call slip requests
displaying, 3-21
unprocessing, 3-21

processing
current call slip requests, 3-8

promote history, 4-26
pull slip, 4-7
purpose

of this document, vii

R

reassign call slip requests, 3-18
reassignment history, 3-20, 4-23, 4-26

view, 3-20
reissue

reason for, vii
Reply Note, 3-9
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